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CMS editor quick reference guide 

The following options are no longer available as icons within the editor. Please follow the 
instructions provided to utilise these features: 
 

Line break Shift + enter at end of line (creates text on new line without a full paragraph 
space between) 

Copy: Select the text and press Ctrl + c on your keyboard 

Cut:   Select the text and press Ctrl + x on your keyboard 

Paste:  Select the text and press Ctrl + v on your keyboard 

Undo:   Select the text and press Ctrl + z on your keyboard 

Heading 1 
(H1): 

Heading level 1 is no longer available as an option. The only H1 on a page should 
be the page title. The page title is created automatically using the heading 
entered at the time of page creation. Any further headings within your content 
should be H2 or lower. Please use the heading numbers from 2-5 to demonstrate 
a clear heading hierarchy within your text and not as attention grabbing 
formatting. 

Paste from 
Word 

This icon does not exist any longer. Content from Word can be pasted directly 
into the editor, however, it may not appear the same as your Word doc content 
and could produce unwanted layout features. It is highly recommended that you 
develop all content text directly in the editor. 

Spell check: Spell check is no longer an icon option within the editor. All spelling will be 
checked automatically by your browser. Any words spelt incorrectly will 
automatically underlined in red. Right click the word and other spelling options 
will be presented in a pop-up menu. 

Image 
formatting: 

There is no longer image formatting capability within the editor. All images 
should be re-sized, or otherwise edited to the correct specifications, externally 
using Paint program (available on all hospital machine) or another photo editor, 
and then uploaded to the CMS in the desired size.  If further image editing is 
required, please contact the ERC Graphic Design department. *A charge for this 
service may be incurred. 

Image link: This feature is not currently available. 

     

The editor has three tabs which house various options. These tabs are Format, Insert and 
Review:  

 

 



Page | 2 
 

 

Format tab 
 

Bold: 

 
Click the word, or highlight multiple words, and select the capital B icon 
__________________________________________________________________________________ 
 

Italics: 

 
Click the word, or highlight multiple words, and select the capital I icon 
__________________________________________________________________________________ 
 

Lists – numbered and dot points: 

       
Type out the items of your list, each on a separate line.  Highlight all the item and select the bullet 
point list icon or the numbered list icon depending on the type of list you want. This will automatically 
format the selected list type. To create s sub-list item within a list, highlight the item and click the 
indent icon arrow forward. 
__________________________________________________________________________________ 

 

Headings and paragraphs: 

 
Select the text you want as a heading and click the desired heading size between heading 2-4. If the 
size you require is not visible, click the double arrow symbol on the side of the headings options box. 
To revert heading text back to normal text, select the text and clock the Paragraph option. 

___________________________________________________________________________ 
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Red-text (Alerts) 

 
Highlight the text, select paragraph from (blue squared box in image), and select ‘Alert’ from the 
second menu box. 
__________________________________________________________________________________ 

 
Indent, Centre, Left-align, right-align, justify: 
 
Follow the same instructions as above for red-text (Alert). Please use these very sparingly. Headings 
and paragraphs should never be centred or right aligned. If in doubt DO NOT USE. 
__________________________________________________________________________________ 

 

Image border and left/right align: 

 
Select image, select option from second menu box. 
_________________________________________________________________________________ 

Insert tab 

Link to an external website page (not on the RCH website): 

1. Click the word, or highlight multiple words, and select the chain link icon. An input box 

will appear with ‘http://’ pre-filled.  

2. Copy the address (URL) of the page you want to link to and paste it into the input box. 

Make sure the ‘http://’ still appears before the ‘www’ of the URL.  

3. The link will now appear to have a blue background. Click the link with your mouse and 

the blue will disappear. (images below) 
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__________________________________________________________________________________ 

Link to another page in the CMS: 

1. Click the word, or highlight multiple words, and select the chain link icon. An input box 

will appear with ‘http://’ pre-filled.  

 

2. Copy the address (URL) of the page you want to link to but only from the forward slash 

directly before the department name (including the forward slash /): 

 

3. Paste this section of the URL into the input box back in the editor 

 

4. The link will now appear to have a blue background. Click the link and the blue will 

disappear 

__________________________________________________________________________________ 

 

In page bookmark links: 

Bookmarks are used to create links within the same page. Please note, it is only possible to link to a 
Heading 2 or Heading 3. Please create content under the appropriate one of these heading types and 
link to the heading to navigate to this text: 
 

1. Copy heading text you wish to link TO using Ctrl + C 
2. Type the link text in the location you want to link FROM 
3. Highlight this link text and from the Insert tab, select the chain link icon 
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4. A box will appear to enter the link. Delete the ‘http://’ that appears in the box 
5. Paste the heading text into this box using Ctrl + V 
6. Replace any capital letters in the heading with lowercase letters. Replace all spaces in the 

heading with a hyphen (-). Replace any special characters with a hyphen (-), ie. replace 
apostrophes with a hyphen 

7. Add a hash symbol (#) at the very beginning of the box. Ie. if you heading title you wish to link 
TO is ‘This is the heading title’ the text in the link box will be: #this-is-the-heading-title 

 
The bookmark is now in place. 
 

__________________________________________________________________________________ 

 

Linked email addresses 

Due to present day cyber security threats, we no longer support the use of linked email addresses. 

Linked email addresses have the potential to be garnered by malicious malware and used in phishing 

and spam attacks. They also have the potential to introduce hostile scripts that can negatively impact 

our entire system. 

__________________________________________________________________________________ 

Library items: 

 
The library filling cabinet icon is now located in the Insert tab. Place your cursor on the page where 
you would like to insert your library item, click the filing cabinet icon and follow the same actions as 
always. Make sure to select the type of media from the drop-down box in the pop-up window that 
appears, i.e. image, file etc. 

___________________________________________________________________________ 

 

Embedded video: 

 

 

Embed video pop-up window: 
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Place your cursor on the page where you want the video to be embedded. Select the icon with the 

red ‘f’ on it. A pop-up box will appear.  Make sure ‘other’ is selected from the drop-down list.  Place 

your video embed code in the ‘Embedded Source’ window and click ‘Embed’ button. 

__________________________________________________________________________________ 

 

 

 

 

Tables: 

 
 

1. Select the table icon from the Insert tab and choose number of columns and rows you want 
for your table. 

2. Please ensure you add class to your table for proper formatting purposes. Instructions on 
following page. 

_____________________________________________________________________________________________________ 
 

Table classes: 

 
 

Inspector pop-up window: 
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When creating a table you need to add classes to them so that they appear nicely formatted when 
they are published, with even cell spacing and so on. 

1. Create your table as per instructions above 
2. From the ‘Review tab’ select the Inspector icon 
3. Within the Inspector pop up window that opens, select the ‘Advanced’ tab 
4. Double click inside a cell of your table 
5. In the Inspector window, select the blue square at the top called ‘Table’. The blue square will 

turn white 
6. In the very bottom textbox, enter the words: 

 
table table-bordered 
 

Close the Inspector window with the white cross in the top-right corner and publish the content when 

you are finished editing. All cells in your table will now be evenly spaced and aligned correctly 

__________________________________________________________________________ 

 

Table rows: 
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Highlight row(s) and options for table rows will appear in a new tab called ‘Table Row’. Select desired 

icon to add row above, add row below, delete row or merge cells. 

___________________________________________________________________________ 

 

Table columns: 

 
Highlight column(s) and options for table columns will appear below the ‘Format, Insert and Review’ 

tabs. Select desired icon to add row above, add row below, delete row or merge cells. 

___________________________________________________________________________ 

 

Special characters: 

 
Place your cursor where you want to add a special character and click the upside-down U icon. Select 

your special character from the options. 

___________________________________________________________________________ 

Review tab 

Inspector: 
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Use this to create in-page links (bookmarks). Please follow the instructions under ‘Bookmarks’ in the 

‘Insert tab’ instructions table. 

__________________________________________________________________________________ 

Code view: 

 
Code view allows users to see and manipulate the content via the code rather than the plain text. 

*This option should not be used by anyone who is unfamiliar with HTML and CSS coding 

languages. 

___________________________________________________________________________ 

General formatting 

There are a few things to keep in mind when formatting your content.  These are: 

 
1. Headings: Only the page title should be a Heading 1. All following headings should be in 

order of importance, in a hierarchy from heading 2 – heading 4. 

2. Heading colours: These are implemented automatically when the content is published.  

3. Font and text colours: Pleases do not attempt to incorporate any specific fonts or text 
colours. These are set automatic when content is saved and anything inserted beyond 
this will not adhere to our branding guidelines. 

4. Referring to the RCH: Use a lowercase ‘t’ for ‘the’ when abbreviating to ‘the RCH’.  If 
spelling out the full name, please use a capital ‘T’ as in ‘The Royal Children’s Hospital’.  
Please ALWAYS use the word ‘the’ in front of the facility’s name. 

5. Use of ‘&’: Please note that the ‘&’ symbol should not be used in page titles. This causes 
issues with the URL address of the page, which is based on the page name. Please spell 
out the full word ‘and’. 

6. Telephone, Facsimile and Email: Please spell out these words in full and do not use a colon 
after them i.e 

 Telephone +61 3 987 654 

 Facsimile +61 3 987 654 

 Email lucy.anderson@rch.org.au 

 

If you have any suggestions for editor related items to add to this list that have not been 

covered, please contact the WebTeam at web.help@rch.org.au. 

mailto:lucy.anderson@rch.org.au

